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Installing

The IBM® Operational Decision Manager installer provides several installation
options, typical and custom, to install the product with various server topologies.

You can install the product with a sample server to test the product features and
run samples and tutorials, with WebSphere® Application Server to benefit from a
cluster environment, or with any other supported application server.

You can also run a silent installation if you plan to install the product on several
computers.

Before proceeding with the installation, make sure that you have a valid license for
the products that you want to install.

Installable components
IBM Operational Decision Manager is composed of several components that
provide a variety of features. Depending on the type of license that you have, you
can install some or all of the components. Ensure that you install only the
components for which you have a license.

You can install the standard version of the product, Operational Decision Manager
Express, or Decision Server Rules Edition.

In addition to the product components, the installer comes with a set of software
that is required for Operational Decision Manager to work with specific
configurations.

For more information about what software is required, see “Checking the software
requirements” on page 5.
Related information:
“Installing the product with Installation Manager” on page 16
If you already installed the required software, you can use Installation Manager to
select the specific Operational Decision Manager packages that you want to install.

Operational Decision Manager licenses
The Operational Decision Manager licenses grant you access to all or some of the
Operational Decision Manager components.

Ensure that you install only the components for which you have a license. When
you install, the Sample Server option in the launchpad installs by default the
complete product. To install select components for which you have a license, you
use either the Custom installation option from the launchpad or you can use
Installation Manager.

You have one of three product licenses:
v Operational Decision Manager
v Operational Decision Manager Express
v Decision Server Rules Edition
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The Operational Decision Manager license grants you access to both the business
rules and the events capabilities.

The Operational Decision Manager Express license grants you access to a limited
configuration of the business rules capabilities. The events capabilities are not
included in the license. Additionally, you cannot use Operational Decision Manager
Express in a cluster environment and you have access to limited capacity. Check
the terms of your license for more information.

The Decision Server Rules Edition license grants you access to the rules
capabilities.

You can install either some or all of the following Operational Decision Manager
components.

Installable Components

Operational
Decision
Manager

Operational
Decision
Manager
Express

Decision Server
Rules Edition

Decision
Server

Rule Designer

A business rule
application
development tool for
developers, modelers,
and architects.

Yes Yes Yes

Event Designer

An event application
development tool for
developers, modelers,
and architects.

Yes No No

Rule Execution
Server

A managed business
rule execution
platform that embeds
the rule engine.

Yes Yes Yes

Event runtime

The event runtime
manages the real-time
business event
coordination that is
defined during
application
development.

Yes No No

Event widgets

Event widgets allow
business users to
interact with the
content provided by
Operational Decision
Manager and other
WebSphere products.

Yes No No
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Installable Components

Operational
Decision
Manager

Operational
Decision
Manager
Express

Decision Server
Rules Edition

Decision
Center

Business console and
Enterprise console

Business console:
Tools for policy
managers for
authoring, searching,
and managing
business rules.

Enterprise console:
Tools for business
analysts for authoring
and managing
business rules and
events.

Yes Yes --

Rule Solutions for
Office

Rule Solutions for
Office is an
environment for
business users to
author rules in
Microsoft Word and
Excel.

Yes Yes --

Event widgets

Business users can
use event widgets to
interact with content
provided by
Operational Decision
Manager and other
WebSphere products.

Yes No --

Profile templates for WebSphere
Application Server

This component includes rules and
events profile templates and the
runtime for deploying Operational
Decision Manager on WebSphere
Application Server.

Yes No Yes

Business Rules Embedded

This component includes a
development environment for adding
business rules functionality to
applications.

Yes No Yes

Sample server

This component includes a server to
run applications, samples, and
tutorials on WebSphere Application
Server Network Deployment.

Yes Yes Yes
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Preliminary steps
Before you install Operational Decision Manager, you must download and
decompress the installer by using an archiving utility of your choice. You must also
make sure that you have the prerequisite software installed.

Downloading the product installers
To install Operational Decision Manager, you must copy or download the
installation disks onto your computer. If you download the files, you have to
decompress them by using an archiving utility of your choice.

About this task

The installation files are available on DVDs or can be downloaded from the IBM
website. Starting the installation from DVDs can be slow. Therefore, the
recommendation is to copy or download the installer files onto your computer
before you start the installation.

You can copy or download onto your computer only the disks that correspond to
the components that you intend to install. Be sure to install all the disks that you
need in the same directory.

Procedure
1. Choose the tar file that corresponds to your target operating system.

To avoid any issue with the file extraction, make sure that the path to the
directory is short. You can, for example, extract the tar files to the root of your
hard disk: C:\ODM851.

2. Extract the files:
v If you use WinZip, clear TAR file smart CR/LF conversion in Option >

Configuration > Miscellaneous.
v If you are an AIX® user, you must use both the native UNIX tar command

and the GNU version of this command because the native utility does not
support long file names.

Results

As a result of the extraction, you obtain three folders named disk1, disk2, and
disk3. Each folder contains the following common elements:
v The launchpad executable file to install the product components along with the

required software.
v The Installation Manager to proceed with the installation of the Operational

Decision Manager components.
v A set of response files to install the product in silent mode.

In addition:
v The disk1 folder contains WebSphere Application Server (WAS directory), IBM

SDK Java™ Technology Edition Version 7.0 for WebSphere (WASJDK7 directory),
and WebSphere eXtreme Scale (WXS repository).

v The disk2 folder contains Decision Server (WDS directory), Profile templates for
WebSphere Application Server (OW directory), and Embedded Rules (ER
directory).
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v The disk3 folder contains Decision Center (WDC directory).
Related concepts:
“Installing the product with the launchpad” on page 10
Operational Decision Manager comes with a launchpad that helps you install the
product along with the additional required software. The launchpad has two
installation options: Sample Server and Custom Installation.
“Installing in silent mode” on page 31
In some cases, Operational Decision Manager has to be installed within a specific
configuration on multiple computers. You can install the product components by
running Installation Manager in silent installation mode to automate the process,
and deploy the products to multiple systems.
“Checking the software requirements”
Before you start installing Operational Decision Manager, make sure that you have
the required software and environments, and that you have sufficient disk space.
Related information:
“Installing the product with Installation Manager” on page 16
If you already installed the required software, you can use Installation Manager to
select the specific Operational Decision Manager packages that you want to install.

Checking the software requirements
Before you start installing Operational Decision Manager, make sure that you have
the required software and environments, and that you have sufficient disk space.

Before you use Operational Decision Manager, you must install the following
programs. These programs are supplied as part of the installer. If they are not
already installed on your computer, you can use the launchpad to install them.

Table 1. Required software to install Operational Decision Manager

Required software Description

Installation Manager V1.6.0 or later Installation Manager is used to install the
Operational Decision Manager packages.

The version of Installation Manager supplied
with the product is 1.6.2.
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Table 1. Required software to install Operational Decision Manager (continued)

Required software Description

WebSphere Application Server Network
Deployment V8.5.0.2

WebSphere Application Server Network
Deployment is required only if you intend to
deploy a sample server or a stand-alone
server.

WebSphere Application Server Network
Deployment is used to run the samples and
tutorials and also to install the Event
runtime and to use the Event Widgets.
Note: To install WebSphere Application
Server Network Deployment on Linux and
AIX systems, you must set the process
resource limits in the /etc/security/
limits.conf file. If the value for the number
of open files is too low, errors can occur
when opening files or establishing
connections. To change the open file limit,
edit the /etc/security/limits.conf file, and
add the following values:

hard nofile 100000
soft nofile 100000

WebSphere eXtreme Scale V8.6.0 WebSphere eXtreme Scale is required only if
you intend to use the Event runtime.

WebSphere eXtreme Scale is used to install
the Event runtime. You must install
WebSphere eXtreme Scale in the directory of
WebSphere Application Server.

For more system and software requirements, go to the following support page:

IBM Operational Decision Manager detailed system requirements
Related tasks:
“Installing the product with the sample server” on page 12
The Sample Server installation option installs the IBM Operational Decision
Manager product family along with the required software. It also creates a sample
server profile on WebSphere Application Server to run the samples and tutorials.
“Installing a custom configuration” on page 14
You use the Custom installation option to install the required software and select
the Operational Decision Manager components and specific features that you want.
This option also allows more specific installation configurations, such as the
installation in an existing Eclipse environment or IBM product. You can also
perform a custom installation using the Installation Manager directly.
Related information:
“Installing the product with Installation Manager” on page 16
If you already installed the required software, you can use Installation Manager to
select the specific Operational Decision Manager packages that you want to install.
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Installation options
Before you install IBM Operational Decision Manager, consider how you want to
use Decision Server and Decision Center, and whether you plan to configure them
on an existing production server. You have several installation options from which
you can select depending on your needs.
Related tasks:
“Installing the product with the sample server” on page 12
The Sample Server installation option installs the IBM Operational Decision
Manager product family along with the required software. It also creates a sample
server profile on WebSphere Application Server to run the samples and tutorials.
“Uninstalling the product” on page 48
To uninstall Operational Decision Manager, you must use the uninstall option of
Installation Manager.
Related information:
“Installing the product with Installation Manager” on page 16
If you already installed the required software, you can use Installation Manager to
select the specific Operational Decision Manager packages that you want to install.

Overview
The Operational Decision Manager installer offers two installation options to adapt
to different server topologies and environments.

The installation options from which you can choose are:
v Sample server
v Custom installation

The first option is available from the launchpad only, but you can perform a
custom installation either by using the launchpad or Installation Manager.

Use the following table to help you decide which installation option is best tailored
to your needs.

Table 2. Installation options

Goal Installation option

Install the complete and ready-to-use
product with no post-installation
configuration to test and evaluate the
product, and to run the samples and
tutorials.

Sample server option from the launchpad.

For more information, see “Typical
installation: Sample Server” on page 8 and
“Installing the product with the sample
server” on page 12.

Install only the components that you want. Custom installation option from the
launchpad or Installation Manager.

For more information, see “Custom
installation” on page 9, “Installing a custom
configuration” on page 14, and “Installing
the product with Installation Manager” on
page 16.
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Table 2. Installation options (continued)

Goal Installation option

Install on a production server.

This installation scenario requires some
configuration after the installation of the
product.

Custom installation option from the
launchpad or Installation Manager.

For more information, see “Custom
installation” on page 9, “Installing a custom
configuration” on page 14, and “Installing
the product with Installation Manager” on
page 16.

Extend an Eclipse environment. Custom installation option from the
launchpad or Installation Manager.

For more information, see “Custom
installation” on page 9, “Installing a custom
configuration” on page 14, and “Installing
the product with Installation Manager” on
page 16.

Install in a compatible IBM product. Custom installation option from the
launchpad or Installation Manager.

For more information, see “Custom
installation” on page 9, “Installing a custom
configuration” on page 14, and “Installing
the product with Installation Manager” on
page 16.

Typical installation: Sample Server
For developing, testing, and running samples and tutorials, select Sample Server in
the launchpad. The sample server option installs a predefined configuration and
profiles for use on WebSphere Application Server.

When you start the launchpad, you can select Sample Server to install the
complete, ready-to-use product and the required software. If you select the sample
server configuration option, you install the complete product family along with the
applications and projects that you use to run the samples and tutorials.

The sample server defines a profile on WebSphere Application Server that contains
the deployed applications to run the samples and tutorials. The sample server is
the default option for developing, testing, and running samples and tutorials. This
option is not for production use. Use the sample server option to test and learn
about the features in Operational Decision Manager. This server includes an
embedded Apache Derby database and WebSphere Application Server default
messaging as the messaging provider.

The sample server does not require any configuration. The profile is created the
first time that you start the sample server after the installation.
Related tasks:
“Installing the product with the sample server” on page 12
The Sample Server installation option installs the IBM Operational Decision
Manager product family along with the required software. It also creates a sample
server profile on WebSphere Application Server to run the samples and tutorials.
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Custom installation
You can use either the launchpad or Installation Manager to customize your
installation of Operational Decision Manager. For example, you can install only a
subset of the Operational Decision Manager components, deploy, and configure
these components on WebSphere Application Server to benefit from clustering
capabilities, or choose specific installation options.

Certain parts of the product require specific software be installed. If the required
software is not already installed, use the launchpad. If the required software is
already installed, or if you want to install a part of the product that does not
require a specific software, you can use Installation Manager: for example, if you
want to install only Rule Designer.

The following figure shows the paths for installing the product by using the
launchpad, or by adding the repository locations in the preferences of Installation
Manager.

To use Operational Decision Manager in a production environment, you must
deploy and configure the archives that correspond to your application server. By
using the custom installation option, you can install the archives to deploy and
configure Decision Center, Decision Server Rules, and Decision Server Events on
WebSphere Application Server.
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For Decision Center and Decision Server Rules only, you can also install the
applications on other supported application servers, such as Apache Tomcat, JBoss
Application Server, Oracle WebLogic Server, or Java SE.

When the installation is complete, go to Configuring to configure Operational
Decision Manager for your application server.
Related tasks:
“Installing a custom configuration” on page 14
You use the Custom installation option to install the required software and select
the Operational Decision Manager components and specific features that you want.
This option also allows more specific installation configurations, such as the
installation in an existing Eclipse environment or IBM product. You can also
perform a custom installation using the Installation Manager directly.
Related information:
“Installing the product with Installation Manager” on page 16
If you already installed the required software, you can use Installation Manager to
select the specific Operational Decision Manager packages that you want to install.

Installing the product with the launchpad
Operational Decision Manager comes with a launchpad that helps you install the
product along with the additional required software. The launchpad has two
installation options: Sample Server and Custom Installation.
Related tasks:
“Installing the product with the sample server” on page 12
The Sample Server installation option installs the IBM Operational Decision
Manager product family along with the required software. It also creates a sample
server profile on WebSphere Application Server to run the samples and tutorials.
“Installing a custom configuration” on page 14
You use the Custom installation option to install the required software and select
the Operational Decision Manager components and specific features that you want.
This option also allows more specific installation configurations, such as the
installation in an existing Eclipse environment or IBM product. You can also
perform a custom installation using the Installation Manager directly.
“Uninstalling the product” on page 48
To uninstall Operational Decision Manager, you must use the uninstall option of
Installation Manager.
Related information:
“Installing the product with Installation Manager” on page 16
If you already installed the required software, you can use Installation Manager to
select the specific Operational Decision Manager packages that you want to install.

Starting the launchpad
Operational Decision Manager comes with a launchpad that helps you install the
product along with the additional required software.

About this task

Each installation disk contains a launchpad executable file. You can start the
launchpad from any disk.
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A web browser is required to run the launchpad, either Firefox or Internet
Explorer.

The user privileges depend on the account that you used to log in to your
computer. However, if you install the product by using the launchpad Custom
installer, you can choose to install in a shared location for multiple users, or to a
single location for a specific user.

You can install Operational Decision Manager either as a regular user or as an
administrator. On Windows7, the Program Files and Program Files (x86)
directories are protected. As a consequence, if you are not installing the product as
an administrator, you might encounter difficulties to run certain programs. To
avoid this issue, install the product in a directory other than Program Files or
Program Files (x86).

On Windows, if you want to install the product as an administrator, the user
privileges that are required for installing it depend on your version of Windows.
v On Windows 7: You must log in with an account that has administrator

privileges to install or update IBM Installation Manager and the other products.
Run the installer as Administrator by right-clicking the program file or shortcut
and selecting Run as Administrator.

Note: If you want to install the Operational Decision Manager components with
a version of Installation Manager that is already installed on your machine,
make sure that the User Account Control setting in the Control Panel is not set
at the lowest value. If this value is set to the minimum, the launchpad is
launched automatically in administrator mode and installs a new version of
Installation Manager in addition to the one that is already installed.

v On Other supported Windows versions if you want to install as an
administrator you must have a user ID that belongs to the Administrator group.

Procedure

To start the launchpad, run one of the following executable files:
v On Windows, run launchpad.exe, or launchpad64.exe for a 64-bit system.

The launchpad.exe and launchpad64.exe files define the bit size that the
launchpad itself runs in. The choice of one or the other does not determine
whether you install a 32 or 64-bit Operational Decision Manager, but whether
the launchpad is run in 32 or 64-bit mode.
In Custom installation mode, you can select whether you want to install a 32-bit
or a 64-bit WebSphere Application Server. In typical modes, the installation is
done in the background and chooses the version that matches the operating
system.

Note: On Windows 7 right-click the file, and select Run as Administrator.
v On Linux, run ./launchpad.sh.

What to do next

Select the type of installation that you want to perform: Sample Server, or Custom
Installation.
Related tasks:
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“Installing the product with the sample server”
The Sample Server installation option installs the IBM Operational Decision
Manager product family along with the required software. It also creates a sample
server profile on WebSphere Application Server to run the samples and tutorials.
“Installing a custom configuration” on page 14
You use the Custom installation option to install the required software and select
the Operational Decision Manager components and specific features that you want.
This option also allows more specific installation configurations, such as the
installation in an existing Eclipse environment or IBM product. You can also
perform a custom installation using the Installation Manager directly.

Installing the product with the sample server
The Sample Server installation option installs the IBM Operational Decision
Manager product family along with the required software. It also creates a sample
server profile on WebSphere Application Server to run the samples and tutorials.

About this task

The sample server installation option installs the following Operational Decision
Manager components:
v IBM Decision Center
v IBM Decision Server

It installs also the tutorial and sample projects, and the following required
software:
v WebSphere Application Server Network Deployment
v WebSphere eXtreme Scale

You can use this component even if you do not have a license for IBM Decision
Center. In this case, your usage is limited to run samples and tutorials.

Procedure

To install IBM Operational Decision Manager with the sample server:
1. Start the launchpad.
2. On the Welcome page, select Sample Server.

3. Specify the directory where you want to install the product.
On Windows 7, if you run the launchpad as an administrator, the proposed
installation directory is:C:\Program Files (x86)\IBM\ODM851.
If you run the launchpad in user mode, the proposed installation directory is:.
C:\Users\IBM_ADMIN\IBM\ODM851 .
You can specify a different location than the one propose by default by
clicking Browse. Note, however, that on Windows7 the Program Files and
Program Files (x86) directories are protected. If you are not installing the
product as an administrator, you might encounter difficulties to run certain
programs. To avoid this issue, install the product in a directory other than
Program Files or Program Files (x86).

4. Enter a user name and password for logging in to the WebSphere Application
Server administration console and other applications such as the Event
Widgets. For example:
v User Name: odmadmin
v Password: odmadmin
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Your user ID and password must not contain any white spaces.

Important:

For security reasons, you must change your password and remove the
temporary response files created by the launchpad after the installation is
complete. These files are generated during the installation process in these
directories:
v On Windows:%TEMP%\IBM_LaunchPad_<InstallType>_<TimeStamp>
v On Unix: /tmp/IBM_LaunchPad_<InstallType>_<TimeStamp>

5. If you have an Operational Decision Manager Express license, select the
corresponding option.
If you want to upgrade from Operational Decision Manager Express to
Operational Decision Manager, you must uninstall the Express version
completely from your computer and then reinstall it by using the launchpad
or Installation Manager.

6. Click Next.
7. Review the license agreement and notices, and select the check box to agree to

the terms.
8. At the bottom of the page, click Install Software.

During the installation, the installer prompts you to confirm that you want to
run the Installation Manager and other installation programs, click Yes to
accept.
The installation runs in the background. Do not close the launchpad even if
the progress bar shows 100% completion. Wait until the following message is
displayed: Installation completed successfully.

9. Click Close, and then click Exit.
10. Click OK to confirm that you want to exit the launchpad.

If you cancel the installation before its completion, the files and folders that
are already copied onto your computer are not deleted. You must uninstall the
products that the launchpad already installed with the Installation Manager,
and manually delete the remaining files before you run the launchpad again.
For more information, see “Uninstalling the product” on page 48.

Results

When the installation is complete, the following elements are installed on your
computer:
v Decision Server Rules: Rule Designer and Rule Execution Server
v Decision Server Events: Event Designer and the event runtime
v Decision Center: Decision Center Business Console and Decision Center

Enterprise Console

By default, they are installed in the following directories:
v Operational Decision Manager: <IBM_InstallDir>/ODM851/ODM, where

<IBM_InstallDir> refers to your IBM installation directory.
v WebSphere eXtreme Scale and WebSphere Application Server:

<IBM_InstallDir>/ODM851/WAS/AppServer, where <IBM_InstallDir> refers to your
IBM installation directory.
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What to do next

Start the sample server with the Start menu shortcut. A profile is configured on
WebSphere Application Server Network Deployment to run the included samples
and tutorials. For more information, see “Get started with the Sample Server” on
page 46.
Related concepts:
“What to do next” on page 46
You might have some configuration work to do post-installation depending on the
installation option that you selected.
“Installation options” on page 7
Before you install IBM Operational Decision Manager, consider how you want to
use Decision Server and Decision Center, and whether you plan to configure them
on an existing production server. You have several installation options from which
you can select depending on your needs.
“Installing the product with the launchpad” on page 10
Operational Decision Manager comes with a launchpad that helps you install the
product along with the additional required software. The launchpad has two
installation options: Sample Server and Custom Installation.
“Checking the software requirements” on page 5
Before you start installing Operational Decision Manager, make sure that you have
the required software and environments, and that you have sufficient disk space.
“Typical installation: Sample Server” on page 8
For developing, testing, and running samples and tutorials, select Sample Server in
the launchpad. The sample server option installs a predefined configuration and
profiles for use on WebSphere Application Server.
Related information:
“Installing the product with Installation Manager” on page 16
If you already installed the required software, you can use Installation Manager to
select the specific Operational Decision Manager packages that you want to install.

Installing a custom configuration
You use the Custom installation option to install the required software and select
the Operational Decision Manager components and specific features that you want.
This option also allows more specific installation configurations, such as the
installation in an existing Eclipse environment or IBM product. You can also
perform a custom installation using the Installation Manager directly.

About this task

The Custom installation option starts the Installation Manager to install Decision
Center, Decision Server, Profile templates for WebSphere Application Server, and
Business Rules Embedded.

You can indicate the user privileges that you want to apply. For example, you can
choose to install the product in a shared location for multiple users.

Use the launchpad to verify that you have the correct versions of the required
software installed. If you do not have the required software installed, use the links
provided in the launchpad to install them.
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Procedure

To perform a custom installation:
1. Start the launchpad.
2. On the Welcome page, select Custom Installation.
3. Specify the user privileges for the installation of the required software and

Operational Decision Manager:
v If you are an administrator or root user and you want to install as an

administrative user, keep the default check box Install in a shared location
for multiple users selected.

v If you are not an administrator or if you want to install to your own user
name, clear the check box Install in a shared location for multiple users.

Note: You must install WebSphere Application Server and Operational
Decision Manager with the same user privileges. For more information, see
“User privileges” on page 18.

4. If you do not have Installation Manager installed, click Install IBM Installation
Manager, and follow the steps in the installation wizard.

5. Click Install IBM WebSphere Application Server Network Deployment to run
install this software.
a. Follow the steps in the installation wizard.

Important: Do not select the option Sample applications in the WebSphere
Application Server feature tree. This prevents the event runtime from
running correctly.

b. At the end of the installation, do not open the Profile Management Tool.
No profile has been created yet.
By default WebSphere Application Server is installed in
<IBM_InstallDir>/WebSphere/AppServer, where <IBM_InstallDir> refers to
your IBM installation directory.

6. Click Install WebSphere eXtreme Scale to install a supported version of
eXtreme Scale using the installation wizard.
a. Follow the steps in the installation wizard.
b. When prompted to indicate the installation directory, make sure that the

path corresponds to your WebSphere Application Server directory. For
example, C:\Program Files\IBM\WebSphere\AppServer. You must install
WebSphere eXtreme Scale in the same directory in which you installed
WebSphere Application Server.
If you get a warning about the version of WebSphere Application Server,
you can ignore it and continue the installation.

c. At the end of the installation, clear Launch the Profile Management Tool
console, and then click Finish.

7. When the installation of the required software is complete, you can either
install each component separately, or install them all in one operation.
v Click one of the following option to install only the corresponding

component:

Decision Center
An environment for business users to author, manage, and test
business rules and event rules.
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Business Rules Embedded
Development environment for adding business rules functionality to
applications. You need an IBM Decision Server license to use this
component and Eclipse 3.6 as your development environment.

Decision Server
Development and runtime environments for business rules and
business events.

Profile templates for WebSphere Application Server
Events and rules template profiles and runtime for deploying
Decision Center and Decision Server on WebSphere Application
Server. You need an IBM Decision Server license to use this
component.

v Click Install Decision Manager to install the four components at once.
The Installation Manager is launched. For more information, see “Running
Installation Manager” on page 20.

Related concepts:
“What to do next” on page 46
You might have some configuration work to do post-installation depending on the
installation option that you selected.
“Custom installation” on page 9
You can use either the launchpad or Installation Manager to customize your
installation of Operational Decision Manager. For example, you can install only a
subset of the Operational Decision Manager components, deploy, and configure
these components on WebSphere Application Server to benefit from clustering
capabilities, or choose specific installation options.
“Installing the product with the launchpad” on page 10
Operational Decision Manager comes with a launchpad that helps you install the
product along with the additional required software. The launchpad has two
installation options: Sample Server and Custom Installation.
“Checking the software requirements” on page 5
Before you start installing Operational Decision Manager, make sure that you have
the required software and environments, and that you have sufficient disk space.
Related information:
“Installing the product with Installation Manager”
If you already installed the required software, you can use Installation Manager to
select the specific Operational Decision Manager packages that you want to install.

Installing the product with Installation Manager
If you already installed the required software, you can use Installation Manager to
select the specific Operational Decision Manager packages that you want to install.

Using Installation Manager, you can install only a subset of Operational Decision
Manager. You can also customize your installation for specific configurations. For
example, you can:
v Extend an existing Eclipse environment
v Install Operational Decision Manager in another compatible IBM product
v Install the archives for configuring an application server other than WebSphere

Application Server
v Install the local help system
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Before you proceed with the installation, make sure that you have a license for the
products you want to install.

IBM Operational Decision Manager is split into components that correspond to
installable units:

IBM Decision Center
An environment for business users to author, manage, and test business
rules and event rules.

IBM Decision Server
Development and runtime environments for business rules and business
events.

Profile templates for WebSphere Application Server
Events and rules template profiles and runtime for deploying Decision
Center and Decision Server on WebSphere Application Server. You need an
IBM Decision Server license to use this component.

Business Rules Embedded
Development environment for adding business rules functionality to
applications. You need an IBM Decision Server license to use this
component and Eclipse 3.6 as your development environment.

To install the Operational Decision Manager components, Installation Manager
must access the corresponding repositories. When you use the product launchpad,
the path to these repositories is set automatically in the Installation Manager
preferences. If you are not using the launchpad, you must specify the repository
URLs in Installation Manager.

After you complete the installation of the products with Installation Manager, you
have to configure Decision Center and Decision Server to use Operational Decision
Manager in production.
Related concepts:
“Installation options” on page 7
Before you install IBM Operational Decision Manager, consider how you want to
use Decision Server and Decision Center, and whether you plan to configure them
on an existing production server. You have several installation options from which
you can select depending on your needs.
“Installing the product with the launchpad” on page 10
Operational Decision Manager comes with a launchpad that helps you install the
product along with the additional required software. The launchpad has two
installation options: Sample Server and Custom Installation.
“Checking the software requirements” on page 5
Before you start installing Operational Decision Manager, make sure that you have
the required software and environments, and that you have sufficient disk space.
“Custom installation” on page 9
You can use either the launchpad or Installation Manager to customize your
installation of Operational Decision Manager. For example, you can install only a
subset of the Operational Decision Manager components, deploy, and configure
these components on WebSphere Application Server to benefit from clustering
capabilities, or choose specific installation options.
“Upgrading to another version” on page 47
Prior to upgrading to a different version of the product or adding or removing
features and functions, you might have to perform preliminary steps.
Related tasks:
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“Installing the product with the sample server” on page 12
The Sample Server installation option installs the IBM Operational Decision
Manager product family along with the required software. It also creates a sample
server profile on WebSphere Application Server to run the samples and tutorials.
“Installing a custom configuration” on page 14
You use the Custom installation option to install the required software and select
the Operational Decision Manager components and specific features that you want.
This option also allows more specific installation configurations, such as the
installation in an existing Eclipse environment or IBM product. You can also
perform a custom installation using the Installation Manager directly.
“Uninstalling the product” on page 48
To uninstall Operational Decision Manager, you must use the uninstall option of
Installation Manager.

Installation Manager overview
You use IBM Installation Manager to install and maintain IBM products.

To use Installation Manager, you must choose the user privileges to perform your
installation and understand what each role involves. You must also be aware of a
few concepts such as package groups, the shared directory, and the Eclipse
languages.

User privileges
You can install Operational Decision Manager as an administrative user (root) or as
a nonadministrative user (nonroot).

You must use the same user to install the required software, for example you must
install Operational Decision Manager and WebSphere Application Server using the
same user.

For more information on the Installation Manager guidelines, see Group road maps
and the user interface and Install as an administrator, non-administrator, or group
in the Installation Manager documentation.

Administrator user

If you want the administrator user (root) to install products on a computer, run the
install executable file that is in the Installation Manager directory.

Nonadministrator user

If you want a specific user to install products on a computer, run the userinst
executable file that is in the Installation Manager directory.

If you want a group of users to install products on a computer, run the groupinst
executable file. If you install Installation Manager using the group mode, you can
install Installation Manager by using one account and offerings by using another
account that is in the same group.

Note:

The group mode is not supported on Windows.

For more information, see Installation commands in the Installation Manager
documentation.
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Package groups and the shared directory
Installation Manager always installs Operational Decision Manager in a package
group, which is used to group multiple packages into one manageable location.

Installation Manager specifies a default “Package group” and a “Shared resources
directory.”

Package group

A package group is a directory where compatible packages share common
components such as a user interface or workbench.

You can create a package group or install the packages into an existing compatible
package group. Some packages cannot share a package group, in which case the
option to use an existing package group is disabled.

You might want to install the product in an existing package group if you installed
supported versions of compatible products such as IBM Integration Designer or
Rational® Application Developer, or Rational Software Architect, and you want to
extend it with Rule Designer and Event Designer features. For more information,
see “Installing Operational Decision Manager in a compatible IBM product” on
page 22.

When you install several packages at the same time, all the packages are installed
into the same package group. After you create the package group, you cannot
change the installation directory. The installation directory contains files and
resources that are specific to Operational Decision Manager.

Shared resources directory

The shared resources directory is where Eclipse plug-ins and other files are located
so that they can be used by one or more product package groups. You can specify
the shared resources directory only the first time that you install a package. The
name of the shared resources directory depends on the first product that you have
installed.

You cannot change the directory location until you uninstall all packages.

Important: Installation Manager manages the contents of the shared resources
directory. You must not edit or modify any files in this directory.
Related tasks:
“Installing Operational Decision Manager in a compatible IBM product” on page
22
You can install Operational Decision Manager in a compatible IBM product
package group to share functions and a common user interface.

Languages
During the installation, you can select the languages to install. English is selected
by default and it is always installed.

Language selection applies only to Eclipse features. A language pack is installed
for each language that you select so that you can start Eclipse in the locale for
these languages.
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If you are extending an existing Eclipse, you must select the languages for which
you already have the language packs installed. If you select a language that is not
already installed in your existing Eclipse, you might get an error. To solve this
issue, clear the languages that are not installed in your Eclipse.

The Rule Designer user interface is installed with all the supported locales.
Therefore, even if you do not install a certain locale, for example French, the Rule
Designer views and editors in Eclipse are still shown in this language (French) if
you start Eclipse in this locale.

Setting up Installation Manager preferences
If you install the product directly from Installation Manager without going through
the launchpad, you must specify the directories of the installers in the preferences.

Procedure
1. Start Installation Manager from the Windows Start menu or from a command

line.
2. Click File > Preferences and specify the repository locations as follows:

v Decision Center: <extractionDir>/disk3/WDC
v Decision Server: <extractionDir>/disk2/WDS
v Profile templates for WebSphere Application Server: <extractionDir>/disk2/

OW

v Business Rules Embedded: <extractionDir>/disk2/ER
Installation Manager retrieves the product packages from the specified
repository locations.
For more information on how to set repository locations, see Repository
preferences in the Installation Manager information center.

Related tasks:
“Running Installation Manager”
You use Installation Manager to install one or more Operational Decision Manager
components on your computer. You can start it directly, or through the launchpad
if you have to install first the required software.

Running Installation Manager
You use Installation Manager to install one or more Operational Decision Manager
components on your computer. You can start it directly, or through the launchpad
if you have to install first the required software.

About this task

If you are installing the product from the Custom installation option of the
launchpad, the paths to the repository locations of the various Operational
Decision Manager components are automatically set in the Installation Manager
preferences.

If you are using Installation Manager directly, make sure that you specify the
repository locations. For more information, see “Setting up Installation Manager
preferences.”

Procedure

To install Operational Decision Manager with Installation Manager:
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1. On the Install Packages page, select Decision Center Decision Server, Business
Rules Embedded, and Profile templates for WebSphere Application Server,
then click Next.
Depending on your needs, you can install one or all of the packages on the
same computer. For more details on the features included in each package, see
“Selecting the features to install” on page 24.

Note: You must have both Decision Center and Decision Server installed to
run the Decision Center samples and to perform the complete scenario for the
Getting Started tutorials.

2. Review the license agreements for the selected packages, click I accept the
terms of the license agreements, and then click Next.

3. Optional: Click Next to accept the default path for the shared resources
directory. Perform this step if Operational Decision Manager is the first
product that you install with Installation Manager.
For more information see, “Package groups and the shared directory” on page
19.

4. Select a package group:
a. Select Create a new package group to create a new package group for

Operational Decision Manager.
The default package group is ODM851 and its name is IBM Operational
Decision Manager.
The default installation directory is C:\Program Files\IBM\ODM851 . On
Windows7, the Program Files and Program Files (x86) directories are
protected. If you are not installing the product as an administrator, you
might encounter difficulties to run certain programs. To avoid this issue,
install the product in a directory other than Program Files or Program Files
(x86).

b. Click Next to continue.
For more information see, “Package groups and the shared directory” on
page 19 and “Installing Operational Decision Manager in a compatible
IBM product” on page 22.

5. To install a new instance of Eclipse, leave the page empty, do not select any
directory, and click Next to continue.
Installation Manager installs a new instance of Eclipse at the root of the
package group directory.
If you already have Eclipse installed and you want to use your installation of
Eclipse, see “Installing the product in an existing Eclipse environment” on
page 23.

6. On the Translations page, select the languages to install for this package, and
then click Next.
For more information, see “Languages” on page 19.

7. Select the product features that you want to install, and then click Next.
A set of features is already selected by default. For more information on the
features, see “Selecting the features to install” on page 24.

8. Select Application Server Location, and browse to your installation of
WebSphere Application Server where you want to deploy the applications,
and then click Next. For example <IBM_InstallDir>/WebSphere/AppServer.
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By default, Operational Decision Manager supports JDK7. If you have an
existing WebSphere Application Server that runs JDK6, you must upgrade
your JDK version by using the installation option IBM WebSphere SDK Java
Technology Edition version 7.0.1.

9. Select Server Security, and enter a user ID and password for the sample
server profile on WebSphere Application Server, and then click Next. For
example:
v User ID: odmadmin
v Password: odmadmin
Your user ID and password must not contain any white spaces.
You use the user ID and password to connect to the WebSphere Application
Server administrative console, the Event Widgets and the Events
Administration console.

10. Optional: Select IBM Operational Decision Manager Express if you have the
corresponding license, and check the Install option.
If you want to upgrade from Operational Decision Manager Express to
Operational Decision Manager, you cannot use the Modify packages option.
You must uninstall the Express version completely from your computer and
then reinstall it by using the launchpad or Installation Manager.

11. On the Summary page, review the selected features before you install the
packages, and then click Install.

12. Wait until the installation is complete, and then click Finish.

Results

The product is installed in the directory that you have specified. The default
installation directory is <IBM_InstallDir>/ODM851, where <IBM_InstallDir> refers to
your IBM installation directory.

The products and features that are installed depend on what you selected in
Installation Manager, see “Checking your installation” on page 36.

What to do next

To find out what your next steps are and how to get started with your installation,
see “What to do next” on page 46.
Related concepts:
“Troubleshooting the installation” on page 44
If you encounter difficulties installing the products, you can check the installation
logs or the limitations and known issues technote.

Installing Operational Decision Manager in a compatible IBM
product

You can install Operational Decision Manager in a compatible IBM product
package group to share functions and a common user interface.

About this task

You can install Operational Decision Manager in the package groups of one of the
following products:
v IBM Integration Designer
v Rational Application Developer
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v Rational Developer for z (RDz)
v Rational Software Architect

Before you start the installation, make sure that the repository locations of these
products are not selected in the preferences of Installation Manager.

Go to the following support page to check the supported versions:
v IBM Operational Decision Manager detailed system requirements

Procedure
1. When prompted to select a package group in Installation Manager, select Use

the existing package group.
Installation Manager displays the list of package groups available. The package
groups that are not compatible are disabled.

2. Select the destination package group.
The installation directory is automatically filled with the path to the selected
product.

3. Continue the installation.
Related concepts:
“Package groups and the shared directory” on page 19
Installation Manager always installs Operational Decision Manager in a package
group, which is used to group multiple packages into one manageable location.

Installing the product in an existing Eclipse environment
Installation Manager installs by default a new instance of Eclipse (version 3.6.2.4).
However, if you already have a supported version of Eclipse, you can choose to
extend it.

Installing the required plug-ins and patch level
Before you install the product in an existing Eclipse environment, make sure that it
contains the required plug-ins, and that the current patch level is installed.

Before you begin

Rule Designer requires Eclipse SDK 3.6 with the following up-to-date features:
v PDE 3.6
v Graphical Editing Framework (GEF) 3.6
v Eclipse Modeling Framework (EMF) 2.6
v Business Intelligence and Reporting Tools (BIRT) 2.6
v Data Tools Platform (DTP) 1.8
v Web Tools Platform (WTP) 3.2
v XSD 2.6

These plug-ins are automatically added as dependencies.

In addition, be sure to install the appropriate patch level. For more information
about obtaining the right level of patch, see the technical notes: Operational
Decision Manager V8.5 Known Limitations.
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Procedure
1. Start Eclipse and click Help > Check for updates.
2. Click Next.
3. Review the items to be updated and click Next.
4. Review the license terms, and select I accept the terms of the license

agreement.
5. Click Finish to install the required components.
6. Click Restart Now if you are prompted to restart Eclipse.

Extending an existing Eclipse environment
If the required plug-ins are installed, you can extend your current Eclipse
environment.

Before you begin

The Eclipse instance to extend must contain an initialization (.ini) file. If there is
no such file, you must create one in the same folder as your Eclipse .exe file. The
.ini file must have the same name as the Eclipse executable file. For example,
eclipse.exe and eclipse.ini.

About this task

The package files are installed in the package group directory that you select, but
the package functions are available in your Eclipse.

Procedure
1. In Installation Manager, when you are prompted to define your Eclipse, select

the check box Extend an existing Eclipse.
2. Browse to your compatible Eclipse IDE installation.
3. Continue the installation.

Selecting the features to install
In Installation Manager, you can select the features that you want to install within
each Operational Decision Manager component.

A default set of features is preselected but you can add or remove features
depending on your needs. For a detailed description of the installable components
and features, see the following sections:
v “Decision Center features” on page 25
v “Decision Server features” on page 27
v “Profile templates for WebSphere Application Server” on page 30
v “Business Rules Embedded” on page 30

Installation Manager automatically enforces any dependencies between features
and prevents you from clearing these dependencies.

After you finish installing the packages, you can add or remove features from your
product with the Modify Packages wizard in Installation Manager.
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Decision Center features

The following table describes the features available for selection in the IBM
Decision Center component.

Table 3. Decision Center features

Feature Description

Decision Center An environment for business users to
author, manage, and test their business and
event rules. It includes a repository for
storing business and event rules, and web
interfaces (Decision Center Business Console
and Decision Center Enterprise Console) for
business users to manage decisions.

By default, Decision Center is installed on
the sample server profile on WebSphere
Application Server. After you complete the
installation of the product, you can also
configure and deploy Decision Center on a
different WebSphere Application Server
profile, or install it on other supported
application servers. However, the Decision
Center Business Console is supported on
WebSphere Application Server V8.0 only.

Decision Center: Installation artifacts for
other application servers > Decision Center
for Tomcat

Provides the archives to deploy and
configure Decision Center on Tomcat. The
archives are copied to <InstallDir>/
teamserver/applicationservers/tomcat.

For more information, see Configuring.

Decision Center: Installation artifacts for
other application servers > Decision Center
for JBoss

Provides the archives to deploy and
configure Decision Center on JBoss. The
archives are copied to <InstallDir>/
teamserver/applicationservers/JBoss.

For more information, see Configuring.

Decision Center: Installation artifacts for
other application servers > Decision Center
for WebLogic Server

Provides the archives to deploy and
configure Decision Center on WebLogic
Server. The archives are copied to
<InstallDir>/teamserver/
applicationservers/WebLogic.

For more information, see Configuring.
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Table 3. Decision Center features (continued)

Feature Description

Decision Center > Event Widgets for
Decision Center

By using the Event Capture widget and the
Event Replay widget, you can capture
events from a production system, and replay
a sequence of events, typically on a test
system.

Event Charting widgets include the Event
Chart Manager widget to create and edit
charts, the Event Chart widget to view
charts as well as real-time charts, which
display the history for events, actions, and
filters.

The Event Tester widget provides a way to
test the event logic in a business process.
This widget is aimed at testing and must be
used only on a test installation. Do not use it
on a production installation as it might
affect performance.

For more information, see Monitoring
business event processing using the chart
widgets

Rule Solutions for Office (for Windows
only)

Rule Solutions for Office provides a way for
business users to create and edit business
rules in Microsoft Word or Excel.

This option copies the installer for Rule
Solutions for Office to your installation
directory. The executable file for the installer
is copied to <InstallDir>/Rule Solutions
for Office/RuleSolutionsForOffice.exe,
see“Installing Rule Solutions for Office” on
page 36

Samples and Tutorials Installs the projects for the samples and
tutorials, and provides the sample server
profile to run the samples and tutorials on
WebSphere Application Server.

WebSphere Application Server is a
prerequisite for this option.
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Table 3. Decision Center features (continued)

Feature Description

Local help system By default this feature is not selected
because the help system points to the online
information center.

You can select the Local help system option
if you prefer accessing the help contents
locally. To use the local help system, you
need an Internet connection only the first
time to download the help contents from the
web. After you download the help contents,
you must set up the local help. For more
information, see Installing and accessing the
documentation locally.
Important: The local help system does not
work on 64-bit platforms, such as Red Hat
Enterprise Linux (RHEL) that do not have a
32-bit compatibility library installed.

Decision Server features

The following table shows the features in the IBM Decision Server package.

Table 4. Decision Server features

Feature Description

Decision Server Rules

Rule Designer Rule Designer is a development environment
within Eclipse to design business rule
applications. It is aimed at developers,
business analysts, and architects. The Rule
Designer views and editors are available from
the Rule perspective in Eclipse.

Rule Designer > Scorecard Modeler Scorecard Modeler is a set of extra plug-ins
that are integrated into Rule Designer. You
can use Scorecard Modeler to create
scorecards, integrate them into your business
rules, and share them across multiple
platforms.
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Table 4. Decision Server features (continued)

Feature Description

Rule Execution Server Rule Execution Server is an execution
platform for business rules that embeds the
rule engine. It also provides a console to
manage and monitor the execution of
business rules.

By default, Rule Execution Server is installed
on the sample server profile on WebSphere
Application Server. After you complete the
installation of the product, you can also
configure and deploy Rule Execution Server
on a different WebSphere Application Server
profile, or install it on other supported
application servers.

Select the type of license that you have:

Non-production license
Select this option if you want to use
the product for development
purposes.

This license can be deployed only as
part of development and test
environment for internal
non-production activities.

Production license
Select this option if you want to use
the product for production.

Rule Execution Server: Installation artifacts
for other application servers > Rule
Execution Server for Tomcat

Provides the archives to deploy and configure
Rule Execution Server on Tomcat. The
archives are copied to <InstallDir>/
executionserver/applicationservers/tomcat.

For more information on how to use the
archives to deploy and configure Rule
Execution Server, see Configuring Rule
Execution Server.

Rule Execution Server: Installation artifacts
for other application servers > Rule
Execution Server for JBoss

Provides the archives to deploy and configure
Rule Execution Server on JBoss. The archives
are copied to <InstallDir>/executionserver/
applicationservers/JBoss.

For more information on how to use the
archives to deploy and configure Rule
Execution Server, see Configuring Rule
Execution Server.

Rule Execution Server: Installation artifacts
for other application servers > Rule
Execution Server for WebLogic Server

Provides the archives to deploy and configure
Rule Execution Server on WebLogic Server.
The archives are copied to
<InstallDir>/executionserver/
applicationservers/ WebLogic.

For more information on how to use the
archives to deploy and configure Rule
Execution Server, see Configuring Rule
Execution Server.
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Table 4. Decision Server features (continued)

Feature Description

Decision Server Events WebSphere Application Server is a
prerequisite for Decision Server Events.

Event Designer A development environment within Eclipse
to design, develop, test, deploy, and monitor
event applications. Event Designer is
available from the Event perspective in
Eclipse.

Runtime > Event Runtime The event runtime is an execution platform
that manages real-time business event
coordination. The event runtime requires
WebSphere eXtreme Scale and must be
deployed and configured on WebSphere
Application Server.

Select the type of license that you have:

Non-production license
Select this option if you want to use
the product for development
purposes.

This license can be deployed only as
part of development and test
environment for internal
non-production activities.

Production license
Select this option if you want to use
the product for production.

Runtime > Event Tester Enabler If Event Tester Enabler is selected, then the
Event Tester widget is available.

Runtime > Event Connectors (Legacy) Event connectors provide data connections
between the event runtime and external
systems. Legacy connectors include email
and ftp.

Event Widgets for Decision Server By using the Event Capture widget and the
Event Replay widget, you can capture events
from a production system, and replay a
sequence of events, typically on a test system.

The Event Tester widget provides a way to
test the event logic in a business process. This
widget is aimed at testing and must be used
only on a test installation. Do not use it on a
production installation as it might affect
performance.

For more information, see Monitoring
business event processing using the chart
widgets.

Integration Components You can install integration components into
the tooling of WebSphere ESB and WebSphere
Message Broker to allow these products to
send and receive data from Decision Server
Events.

Shared components
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Table 4. Decision Server features (continued)

Feature Description

Samples and Tutorials Installs the projects for the samples and
tutorials, and provides the sample server
profile to run the samples and tutorials on
WebSphere Application Server.

WebSphere Application Server is a
prerequisite for this option.

Update sites for installation into other
Eclipse products

Provides compressed files that contain the
Eclipse update sites (and a copy of the
Designer plug-ins) to install Rule Designer
and Event Designer features into an existing
Eclipse. This feature provides an alternate
way of installing the Designer plug-ins into a
supported Eclipse after the installation of
Operational Decision Manager.

For more information, see Extending Eclipse
with the Rule Designer update sites.

Local help system By default this feature is not selected because
the help system points to the online
information center.

You can select the Local help system option
if you prefer accessing the help contents
locally. To use the local help system, you
need an Internet connection only the first
time to download the help contents from the
web. After you download the help contents,
you must set up the local help. For more
information, see Installing and accessing the
documentation locally.
Important: The local help system does not
work on 64-bit platforms, such as Red Hat
Enterprise Linux (RHEL) that do not have a
32-bit compatibility library installed.

Profile templates for WebSphere Application Server

This component contains the events and rules template profiles and runtime that
are required to deploy Operational Decision Manager on a WebSphere Application
Server.

For details on profile templates, see Operational Decision Manager profile
templates.

Business Rules Embedded

With Business Rules Embedded, you can use business rules to dynamically
configure the behavior of an Eclipse Rich Client Platform (RCP) application or a
Dojo-based web application.

For detailed information about this component, see Business Rules Embedded.
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Installing in silent mode
In some cases, Operational Decision Manager has to be installed within a specific
configuration on multiple computers. You can install the product components by
running Installation Manager in silent installation mode to automate the process,
and deploy the products to multiple systems.

You perform a silent installation by running Installation Manager with response
files that correspond to the products that you want to install. Template response
files are provided with the installer to help you perform a silent installation.

Installing Installation Manager silently
You can install Installation Manager silently with the Installation Manager installer,
and then use it to install silently the product packages.

About this task

In silent mode, there is no interaction with the Installation Manager user interface.

Operational Decision Manager is bundled with Installation Manager version 1.6.2.
Installation Manager version 1.6.0 or later is required to install the Operational
Decision Manager products.

Procedure

To install Installation Manager silently:
1. Go to the location where you extracted the Operational Decision Manager

installation disks and go to: diskX\IM\.
The IM directory is available from any disk. If you use Linux 64-bit, the
directory is IM64.

2. Go to the directory diskX\responsefiles.
The responsefiles directory is available from any disk.

3. In the file IM_Silent.xml, replace !IM_REPOSITORY! with the path to the
directory where the Installation Manager installer is located. A typical value is:
<install_root>\diskX\IM.

4. Run one of the following commands:
v If you are an administrator:

installc.exe -input <path_to_silent_file>\IM_Silent.xml -acceptlicense

v If you are not an administrator:
userinstc <path_to_silent_file>\IM_Silent.xml -acceptlicense

Setting the response file for required software
WebSphere Application Server and WebSphere eXtreme Scale are prerequisites to
the installation of the other Operational Decision Manager packages. WebSphere
eXtreme Scale is required if you want to install Decision Server Events. You can
install them silently using the provided response files.

About this task

Installation Manager uses response files to run the installation in silent mode. The
following procedure explains how to set up the provided response files to run a
silent installation for WebSphere Application Server and WebSphere eXtreme Scale.
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Procedure

Setting up the response file for WebSphere Application Server

1. Go to the location where you extracted the Operational Decision Manager
installation disks and go to: diskX\responsefiles.
Response files are available on any disk.

2. In the file Prerequisites_WAS_Silent.xml, replace !WAS_REPOSITORY! with the
path where the WebSphere Application Server installer is located. For example:
<install_root>\disk1\WAS.

3. Replace the variable !WAS_PROFILE_ID! by any string. This value is used
internally by Installation Manager to give a name to the WebSphere Application
Server installation profile.

4. Replace the variable !WAS_HOME! by the path to the directory where you want to
install WebSphere Application Server. For example: c:\Program Files\IBM\WAS.

5. If you want to install WebSphere Application Server in 64-bit mode, replace the
variable !BIT_64! by the value indicated in the file . Otherwise, delete this line.

6. Replace the variable !WAS_SDK_FEATURE_BIT_ 32_OR_64! by the value
com.ibm.sdk.6_32bit or com.ibm.sdk.6_64bit depending on whether you want
to install a 32-bit or a 64-bit WebSphere Application Server.

Setting up the response file for WebSphere eXtreme Scale

7. Go to the location where you extracted the Operational Decision Manager
installation disks and go to: diskX\responsefiles.
Response files are available on any disk.

8. Set the value of -OPT installLocation in the file wxssetup.response.xml to
indicate the path to the directory where WebSphere Application Server is
installed. For example: c:\Program Files\IBM\WAS.

Setting the response file for Decision Server and Decision
Center

In the same way as you set up a response file for WebSphere Application Server
and WebSphere eXtreme Scale, you can configure a response file for the silent
installation of the Operational Decision Manager packages: Decision Center and
Decision Server.

About this task

Installation Manager uses response files to run the installation in silent mode. The
following procedure explains how to set up the provided response files to run a
silent installation for Decision Center and Decision Server.

Procedure
1. Go to the location where you extracted the Operational Decision Manager

installation disks and go to diskX\responsefiles.
Response files are available on any disk.

2. In the file WODM_Silent.xml, replace !WDC_REPOSITORY! and !WDS_REPOSITORY!
with the path where the Decision Center and Decision Server installers are
located.
For example: <install_root>\disk3\WDC for Decision Center, and
<install_root>\disk2\WDS for Decision Server.
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3. Replace the variable !WODM_PROFILE_ID! by the value that is used internally by
Installation Manager to give a name to the Operational Decision Manager
installation profile: Operational Decision Manager V8.5.
This profile corresponds to the Installation Manager profile, not to the
WebSphere Application Server profile.

4. Replace the variable !WODM_HOME! by the path to the directory where you want
to install Operational Decision Manager. For example, c:\Program
Files\IBM\ODM851.

5. Replace the variables !ADMIN_USERNAME! and !ADMIN_PASSWORD! by the username
and password that are required by WebSphere Application Server for security
purposes.

6. Replace the variable !EXPRESS_OPTION! by true if you have an Operational
Decision Manager Express license. If you do not set this value to true the
standard version of the product is installed by default. Make sure that you
have a license that corresponds to the type of installation that you are going to
perform.

7. Replace the variables !WODM_FEATURES_DECISION_CENTER!,
!WODM_FEATURES_DECISION_SERVER_RULES!, and
!WODM_FEATURES_DECISION_SERVER_EVENTS! with a comma-separated list of the
features that you want to install.
The following table provides a complete lists of all the features available. For a
detailed description of these features, see “Selecting the features to install” on
page 24.

Table 5. List of features to install

Product List of features

Decision
Center

v jdk

v base

v Decision Center

v Rule Solutions for Office

v com.ibm.wdc.rules.samples.feature

v com.ibm.wbdm.dts.tomcat.feature

v com.ibm.wbdm.dts.jboss.feature

v com.ibm.wbdm.dts.weblogic.feature

v com.ibm.wdc.event.widgets.feature

Decision
Server
Rules

v com.ibm.wds.jdk.feature

v base

v com.ibm.wds.updatesites.feature

v com.ibm.wds.rules.studio.feature

v com.ibm.wds.rules.res.feature

v com.ibm.wds.rules.samples.feature

v com.ibm.wds.rules.scorecard.feature

v com.ibm.wds.rules.res.tomcat.feature

v com.ibm.wds.rules.res.jboss.feature

v com.ibm.wds.rules.res.weblogic.feature
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Table 5. List of features to install (continued)

Product List of features

Decision
Server
Events

v com.ibm.wds.jdk.feature

v base

v com.ibm.wds.updatesites.feature

v com.ibm.wds.studio.events.feature

v com.ibm.wds.events.runtime.feature

v com.ibm.wds.events.connectors.feature

v com.ibm.wds.events.integration.feature

v com.ibm.wds.events.propertiesui.feature

v com.ibm.wds.event.widgets.feature

v com.ibm.wds.events.tester.feature

Related concepts:
Operational Decision Manager Express

Setting the response file for Profile templates for WebSphere
Application Server

If Decision Center and Decision Server are to be deployed on WebSphere
Application Server, you can set up a response file to install the corresponding
profile templates and runtime silently.

About this task

Installation Manager uses response files to run the installation in silent mode. The
following procedure explains how to set up the provided response files to run a
silent install for Profile templates for WebSphere Application Server.

Procedure
1. Go to the location where you extracted the Operational Decision Manager

installation disks and go to: diskX\responsefiles.
Response files are available on any disk.

2. In the file OW_Silent.xml, replace !OW_REPOSITORY! with the path where the
Profile templates for WebSphere Application Server installer is located. For
example: <install_root>\disk1\OW.

3. Replace the variable !WODM_PROFILE_ID! by the value used internally by
Installation Manager to give a name to the Operational Decision Manager
installation profile: Operational Decision Manager V8.5.
This profile corresponds to the Installation Manager profile, not to the
WebSphere Application Server profile.

Installing Operational Decision Manager silently
After all the response files are set up, you can start a silent installation.

About this task

The following procedure explains how to perform a silent installation of
Operational Decision Manager with Installation Manager. The installation must be
performed in the shown order.
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Procedure
1. To install Installation Manager:

v If you are an administrator, type:
installc.exe -input <path_to_silent_file>\IM_Silent.xml -acceptlicense

v If you are not an administrator, type:
userinstc <path_to_silent_file>\IM_Silent.xml -acceptlicense

2. To install WebSphere Application Server:
v On Windows systems:

a. Go to the directory where you have installed Installation Manager.
b. Go to the directory eclipse\tools.
c. Type the command imcl.exe -input <path_to_response_file>\

Prerequisites_WAS_Silent.xml -acceptLicense.
v On Unix systems:

a. Go to the directory where you have installed Installation Manager.
b. Go to the directory eclipse/tools.
c. Type the command ./imcl input <path_to_response_file>/

Prerequisites_Silent.xml -acceptLicense.
3. To install WebSphere eXtreme Scale:

v On Windows systems:

a. Go to the directory <install_root>\WXS.
b. Type the command:

imcl.exe -input <path_to_response_file>\WXS_Silent.xml
-acceptLicense

v On Unix systems:

a. Go to the directory <install_root>\WXS.
b. Type the command:

./imcl input <path_to_response_file>/WXS_Silent.xml -acceptLicense

4. To install the Operational Decision Manager components:
v On Windows systems:

a. Go to the directory where you have installed Installation Manager.
b. Go to the directory eclipse\tools.
c. Type the command:

imcl.exe -input <path_to_response_file>\WODM_Silent.xml
-acceptLicense

v On Unix systems:

a. Go to the directory where you have installed Installation Manager.
b. Go to the directory eclipse/tools.
c. Type the command:

./imcl input <path_to_response_file>/WODM_Silent.xml -acceptLicense

5. To install Profile templates for WebSphere Application Server:
v On Windows systems:

a. Go to the directory where you have installed Installation Manager.
b. Go to the directory eclipse\tools.
c. Type the command:

imcl.exe -input <path_to_response_file>\OW_Silent.xml
-acceptLicense
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v On Unix systems:

a. Go to the directory where you have installed Installation Manager.
b. Go to the directory eclipse/tools.
c. Type the command:

./imcl input <path_to_response_file>/OW_Silent.xml -acceptLicense

Installing Rule Solutions for Office
Once the installation of Decision Center is complete, you can manually run the
installer for Rule Solutions for Office.

Before you begin

If you installed the product with Installation Manager, make sure that you selected
the Rule Solutions for Office feature, see “Selecting the features to install” on
page 24.

You must have a supported version of Microsoft Office to install Rule Solutions for
Office. For details, see Working with Microsoft Office.

About this task

Rule Solutions for Office is an optional component that provides a way for
business users to create and edit business rules in Microsoft Word or Excel. The
Rule Solutions for Office feature in Installation Manager copies the installer for
Rule Solutions for Office to your installation directory.

Procedure
1. Navigate to <InstallDir>/Rule Solutions for Office/

2. Double-click the RuleSolutionsForOffice.exe file to run it.
3. Follow the steps in the installation wizard.

Checking your installation
You can verify the content of the installation directory and use shortcuts to access
product components and information.

Folders in the installation directory
After you finish installing the Operational Decision Manager components, you can
verify the content of the installation directory.

In your file system, go to your <InstallDir> folder: for example, C:\Program
Files\IBM\ODM851. The Operational Decision Manager components are installed in
the following folders:

Table 6. Component-folder mapping

Component Folders

Decision Server Rules

Rule Designer studio

Rule Execution Server executionserver

Getting started tutorials gettingstarted

Shared third-party tools shared
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Table 6. Component-folder mapping (continued)

Component Folders

Sample server shared/sampleServer

.NET engine and migration tool dotnet

Configuration files and plug-ins for Rule
Designer

configuration

Local help system and XML schemas doc

Extensions to Rule Designer dropins

Files to package plug-ins into a feature
during Eclipse configuration processing

features

Eclipse plug-ins plugins

JDK (Windows only) jdk

License agreement files license

Provisioning system files p2

Decision Server Events

Legacy event connectors connectors

Files that support the event runtime engine.
This directory also includes the compressed
files for downloading and installing the
Event Chart widget, the Event Chart
Manager, the Event Tester, and the Event
Capture and Event Replay widgets.

runtime

Events connectors ca

Configuration files config

Configuration files and plug-ins for Event
Designer

configuration

Extensions to Event Designer dropins

Integration with other IBM products such as
WebSphere Message Broker and WebSphere
ESB

integration

Decision Center teamserver, Rule Solutions for Office
(optional)

Business Rules Embedded rules-sdk

IBM Installation Manager installs the Eclipse plug-ins in the shared resources
directory. The shared resources directory contains resources that can be shared by
one or more package groups. This directory is managed by IBM Installation
Manager and you must not modify anything in this directory.

The Eclipse plug-ins are also copied to <InstallDir>/studio/update-sites
providing that you selected the corresponding option in IBM Installation Manager
when installing the product. The update sites are delivered as ZIP files that you
can extract to view the plug-ins.

If you install the component Profile templates for WebSphere Application Server,
the corresponding folders are located in the following directories:

<WAS_InstallDir>/profileTemplates/rules for rules profiles.
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<WAS_InstallDir>/profileTemplates/wbe for events profiles.

Menu shortcuts
A list of the components that the installer adds to the shortcut menu, accessible via
the start menu.

Your choice of installation determines what shortcuts the installer adds to the
shortcut menu. If, for example, you choose Rule Designer, the shortcut for Rule
Designer is added. If you choose Rule Execution Server, the shortcut for the Rule
Execution Server console is added.

Start menu navigation Shortcuts

Start > All Programs > IBM >
Package_Group

The following is available under the package group
level:

v Event Designer opens Eclipse in the Event
perspective.

v Information center for Operational Decision
Manager.

v Rule Designer opens Eclipse in the Rule
perspective.

v Rule Solutions for Office opens rule solutions for
Office. This shortcut is only available if you install
Rule Solutions for Office. To install Rule Solutions
for Office, you must select the corresponding
option in Installation Manager. You then run the
installation manually by using the provided .exe
file in <InstallDir>/Rule solutions for Office.

Start > All Programs > IBM >
Package_Group > Getting Started
Tutorials

The following is available under Getting Started
tutorials:

v Decision Center Business console opens the
Getting Started for the Business console.

v Decision Center Enterprise console opens the
Getting Started for the Enterprise console.

v Decision Server Events opens the Getting Started
for Events.

v Decision Server Rules opens the Getting Started
for Business Rules.

Start > All Programs > IBM >
Package_Group > Help and
Support

You can use this shortcut to find the following
documentation and support information:

v Collect Data for Problem Analysis opens the IBM
Support Assistant Data Collector for collecting
diagnostic data.

v Online Support opens the IBM Support home
page.

38 IBM Operational Decision Manager: Installation Guide



Start menu navigation Shortcuts

Start > All Programs > IBM >
Package_Group > Sample Server

You can use this shortcut to access the following
sample server tools and functions.

v Events tools:

– Connectors opens the tooling for Events legacy
connectors.

– Event Widgets opens the web application in a
web browser.

– Properties opens the Properties tool.

v Administrative console opens the WebSphere
Application Server administrative console.

v Decision Center Business console opens the
Decision Center Business console and targets a
database that contains the provided sample
projects in the en_US persistence locale.

v Decision Center Enterprise console opens the
Decision Center Enterprise console, and targets a
database that contains the provided sample
projects in the en_US persistence locale.

v Events Administration console opens the
Administration user interface for Events.

v Rule Execution Server Console opens the Rule
Execution Server console.

v Samples console (en_US) opens Eclipse in the
Samples console perspective with the en_US locale
(American English).

v Start server starts the sample profile on
WebSphere Application Server.

v Stop server stops the sample profile on
WebSphere Application Server.

Shortcut commands
A list of the components that you can access via shortcut commands.

The installer adds relevant shortcuts in batch (.bat) files on Windows and Bash
shell script (.sh) files on Linux.

You can consult the shortcut commands for your respective operating system
environment:
v “Windows”
v “Linux” on page 40

Windows

Shortcuts Windows commands

Administrative console (Sample
Server)

<InstallDir>/shared/bin/
Administrativeconsole.bat

Connectors <InstallDir>/connectors/bin/connectors.bat

Decision Center Enterprise console
(Sample Server)

<InstallDir>/shared/bin/dcecopener.bat

Decision Center Business console
(Sample Server)

<InstallDir>/shared/bin/dcbcopener.bat
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Shortcuts Windows commands

Events Administration console <InstallDir>/shared/bin/EventRuntimeopener.bat

Event Designer <InstallDir>/eclipse.exe -init -consolelog
-perspective com.ibm.wbe.BusinessEvents

Getting Started for Decision Server
Rules

<InstallDir>/images/
GettingStartedServerRules.bat

Getting Started for Decision Center
Business console

<InstallDir>\images\
GettingStartedCenterBusinessConsole.bat

Getting Started for Decision Center
Enterprise console

<InstallDir>\images\
GettingStartedCenterEnterpriseConsole.bat

Getting Started for Decision Server
Events

<InstallDir>\images\
GettingStartedServerEvents.bat

Information center (remote) <InstallDir>/images/InfoCenterOnline.bat

Collect Data for Problem Analysis <InstallDir>/shared/isadc/index.html

Properties <InstallDir>/connectors/bin/propertiesui.bat

Rule Execution Server console
(Sample Server)

<InstallDir>/shared/bin/dsopener.bat

Rule Designer <Eclipse_InstallDir>/eclipse.exe -init
-consolelog -perspective
ilog.rules.studio.ui.perspectives.RuleEditingPerspective

Samples console (en_US) <Eclipse_InstallDir>/eclipse.exe -init
-consolelog -nl en_US -perspective
ilog.rules.studio.samples.console.perspectives.SamplesPerspective

Start server (Sample Server) <InstallDir>/shared/bin/startserver.bat

Stop server (Sample Server) <InstallDir>/shared/bin/stopserver.bat

Linux

Shortcuts Linux commands

Administrative console (Sample
Server)

<InstallDir>/shared/bin/Administrativeconsole.sh

Connectors <InstallDir>/connectors/bin/connectors.sh

Decision Center Enterprise console
(Sample Server)

<InstallDir>/shared/bin/dcecopener.sh

Decision Center Business console
(Sample Server)

<InstallDir>/shared/bin/dcbcopener.sh

Events Administration console <InstallDir>/shared/bin/EventRuntimeopener.sh

Event Designer <InstallDir>/eclipse -init -consolelog
-perspective com.ibm.wbe.BusinessEvents

Getting Started for Decision Server
Rules

<InstallDir>/images/GettingStartedServerRules.sh

Getting Started for Decision Center
Business console

<InstallDir>\images\
GettingStartedCenterBusinessConsole.sh

Getting Started for Decision Center
Enterprise console

<InstallDir>\images\
GettingStartedCenterEnterpriseConsole.sh

Getting Started for Decision Server
Events

<InstallDir>\images\
GettingStartedServerEvents.sh

Information center (remote) <InstallDir>/images/InfoCenterOnline.sh
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Shortcuts Linux commands

Collect Data for Problem Analysis <InstallDir>/shared/isadc/start_isadc.sh

Properties <InstallDir>/connectors/bin/propertiesui.sh

Rule Execution Server console
(Sample Server)

<InstallDir>/shared/bin/dsopener.sh

Rule Designer <Eclipse_InstallDir>/eclipse -init -consolelog
-perspective
ilog.rules.studio.ui.perspectives.RuleEditingPerspective

Samples console (en_US) <Eclipse_InstallDir>/eclipse -init -consolelog
-nl en_US -perspective
ilog.rules.studio.samples.console.perspectives.SamplesPerspective

Start server (Sample Server) <InstallDir>/shared/bin/startserver.sh

Stop server (Sample Server) <InstallDir>/shared/bin/stopserver.sh

Installing and accessing the documentation locally
By default, the help system connects to the information center using the internet.
However, you can install the documentation locally or on a network if you select
the Local help system option in Installation Manager.

Installing the product documentation on your computer
To install a local copy of the information center, you start the help system that you
installed by selecting the Local help system option in Installation Manager and
then download the documentation.

Before you begin

When you install the product by using Installation Manager, select the Local help
system option to install the help system on your computer.

About this task

By default, the help system connects to the documentation over the internet.
However, you can install the documentation locally on your machine instead. This
option is useful if you want to view the documentation offline or on a computer
without internet access. To set up a local version of the documentation, you start
the help system, and then download and install the plug-ins.

Note:

To download the documentation, you need access to the internet.

Important:

The local help system does not work on 64-bits platforms such as Red Hat
Enterprise Linux (RHEL) that do not have a 32-bits compatibility library installed.

Procedure
1. Start the help system in one of the following ways:

v In the Start menu, click All Programs > IBM > package_group >
Information center for Operational Decision Manager (local).
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package_group refers to the package group specified in IBM Installation
Manager during installation. The default package group is Operational
Decision Manager.

v Run the following script:
– <InstallDir>/doc/help_start.bat on Windows
– <InstallDir>/doc/help_start.sh on Linux.

To run the information center in a locale other than English, add the locale
argument (-nl xx_XX) to the <InstallDir>/doc/help_start.bat or
<InstallDir>/doc/help_start.sh file, before the -vmargs argument. For
example:
-eclipsehome eclipse -nl fr_FR -configuration configuration_iehs

A new browser window opens. The documentation does not display because
you still must download the documentation content.

Note:

If you installed the product on Windows 7 in the Program Files or Program
Files (x86) directory without administrator privileges, you might not be
able to start the help system. To avoid potential issues, be sure to install the
product with administrator rights or in a different directory.

2. Click Update in the toolbar to display a list of the documentation sets that
are already installed.

3. Click Next to display a list of documentation sets that you can install. The list
includes documentation sets in English and other supported languages, as well
as documentation for other products.

4. Select the documentation sets that you want to install.
5. Click Install. The Update wizard installs the documentation.
6. Click OK, then click Finish.
7. Refresh the page to view the documentation.

Results

The documentation is installed on your computer.

Accessing the local contextual help in Rule Designer
To access the local help system from Rule Designer you must first install the
documentation locally.

Before you begin

If you want to access the documentation locally rather than online in Rule
Designer, make sure that you have selected the Local help system option in
Installation Manager. You can modify the options selected in Installation Manager.
After installing the documentation locally you no longer need an Internet
connection to access the local information center. For more information, see
“Installing the product documentation on your computer” on page 41.

Remember: If you do not have specific needs for using local help rather than
online help, you do not have to select the Local help system option in Installation
Manager. By default, the online help is activated and no configuration is required.
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About this task

To use the local contextual help from Rule Designer, you must start the local
instance of the information center. The installer inserts the necessary parameters to
access the help from Rule Designer.

If you want to change the parameters to point to a different instance of the
information center, for example a shared information center server running on an
internal network, you can modify the values in Rule Designer.

Procedure

To access the local help in Rule Designer:
1. Check that the settings to use the local help are set correctly in Rule Designer:

a. Click Window > Preferences > Help > Content.
b. Make sure Include remote help and give it priority is selected.
c. Select the link to the information center and click Edit.
d. Make sure that the local information center has the following values:

v Name: Operational Decision Manager information center
v Host: localhost
v Path: /help
v Use port: 3333

e. Click OK, and then click Apply and OK.
2. Start the local help:

v In the Start menu, click All Programs > IBM > package_group >
Information center for Operational Decision Manager (local).

v Run the <InstallDir>/doc/help_start.bat (Windows) or
<InstallDir>/doc/help_start.sh (Linux)

3. On the Help menu, click Help Contents.
If you have already installed the documentation, the local information center
for the Operational Decision Manager product family, Decision Center, and
Decision Server is displayed.
If the documentation has not been installed, follow the steps as described in
“Installing the product documentation on your computer” on page 41.

Running a shared information center on an internal network
You can run the information center on an internal network.

Before you begin

Before running the information center on an internal network, make sure that you
have installed the documentation locally as described in “Installing the product
documentation on your computer” on page 41.

About this task

If you have selected the Local help system option, you can set the help system up
so that the information center runs on an internal network.
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Procedure

To start the information center on an internal network:
1. Run <InstallDir>/doc/IC_start.bat on Windows or <InstallDir>/doc/

IC_start.sh on Linux.
By default, the shared information center runs on port 9999.

2. Optional: To modify the default port, edit the IC_start.bat or IC_start.sh file,
and modify the port argument. For example, -port <port_number>.
When the shared information center is started, it is accessed using browsers
from other systems at the address http://<hostname>:<port>/help.

Note: To access different locales in the information center, specify the locale at
the end of the URL. For example, http://<ic_hostname>:9999/help/
index.jsp?lang=xx_XX

The locales include de_DE, es_ES, fr_FR, it_IT, ja_JP, ko_KR, pl_PL, pt_BR,
ru_RU, zh_CN, and zh_TW.

3. Optional: Configure the help preferences in Rule Designer to access the
information center:
a. Click Window > Preferences > Help > Content.
b. Select Include remote help and give it priority, then click New.
c. Enter the values for the information center that you want to connect to, for

example:
v Name: Operational Decision Manager information center
v Host: <ic_hostname>
v Path: /help
v Use port: 9999

d. Click OK, and then click Apply and OK.
The contextual help now uses your new parameters.

Stopping the local help
Before uninstalling the Operational Decision Manager offerings in Installation
Manager, you must stop the information center process to avoid encountering
uninstallation issues.

To stop the local information center:
v On Windows, run <InstallDir>/doc/help_end.bat.
v On Linux, run <InstallDir>/doc/help_end.sh.

To stop the shared information center:
v On Windows, run <InstallDir>/doc/IC_end.bat.
v On Linux, run <InstallDir>/doc/IC_end.sh.

Troubleshooting the installation
If you encounter difficulties installing the products, you can check the installation
logs or the limitations and known issues technote.

When you contact IBM support, make sure that you have the following
information at hand:
v Version of Installation Manager installed
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v Components installed and version numbers
v Operating system
v Installation Manager logs

Installation logs

If you have difficulties installing the product through Installation Manager,
retrieve the installation logs to find out more information on the issues
encountered.
v Installation Manager:

– Windows 2000, XP, and 2003: C:\Documents and Settings\All
Users\Application Data\IBM\Installation Manager\logs

– Windows Vista, 7, and 2008: C:\ProgramData\IBM\Installation
Manager\logs\.settings\logs

– UNIX: /var/ibm/InstallationManager/logs

For more information, see Finding IBM Installation Manager
troubleshooting logs.

v Launchpad:
– Windows: %TEMP%\IBM_LaunchPad_<InstallType>\

%TEMP% is the environment variable that defines the location of your
Temp directory. <InstallType> refers to the type of installation that you
selected. If the launchpad fails before even starting the installation, no
installation type is indicated in the folder name.

– UNIX: /tmp/IBM_LaunchPad_<InstallType>/

Limitations and known issues

To find a list of the current limitations and known issues, check the
technote Known limitations in Operational Decision Manager V 8.5.1

Setting up your environment to automate processes
To deploy RuleApps to Rule Execution Server, automate managerial tasks within
Decision Center, and run many of the samples, you must have Ant installed on
your computer.

About this task

The required version of Ant is 1.7.1 (or later). If Ant is not installed, or your
version is older than version 1.7.1, you must set up your environment to use the
correct version of Ant.

You can download Ant from http://ant.apache.org/, or you can use the Ant 1.7.1
distribution packaged in the following directory: <InstallDir>/shared/tools/ant.

Procedure

To test and set up your environment to use Ant:
1. Set the ANT_HOME environment variable to <InstallDir>/shared/tools/ant.
2. Set the JAVA_HOME environment variable to the path to your JDK installation

(version 1.7.1).
3. Add the directory <InstallDir>/shared/tools/ant/bin to your PATH

environment variable.
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4. Test your current version of Ant by typing the following in a Windows
command prompt or UNIX shell:
ant -version

What to do next
You might have some configuration work to do post-installation depending on the
installation option that you selected.
v Sample server installation: No configuration is required to develop, test, and run

the tutorials and samples. See “Get started with the Sample Server.”
v Custom installation: To use your rules empowered applications, you must

configure the Operational Decision Manager applications on a production server.
See “Use your application in production” on page 47.

v Stand-alone server installation. See What's new for developers.

Get started with the Sample Server

The first time that you start the sample server, a profile (ODMSample) is
configured on WebSphere Application Server Network Deployment to run the
included samples and tutorials. You can start the sample server with the Start
menu shortcut.

On the Start menu, click All Programs > IBM > package_group > Sample Server >
Start server. package_group refers to the package group specified in IBM Installation
Manager during installation. The default package group is Operational Decision
Manager V8.5.1.

The profile creation takes several minutes to complete. Wait until the build
completes successfully.

You can perform a number of introductory tasks using the environment that is
installed for you by the sample server installer:
v Perform the Getting started tutorials, and other component-specific tutorials, see

Getting started tutorials and Product tutorials
v Run the samples from the samples console in Eclipse, see Product samples.

For more information, see Using the sample server

Note:

v If you are using the sample server profile to run Events, you can use the same
username and password to log in to the Event Widgets and to the Events
Administration console.

v Single sign-on (SSO) authentication is activated for the sample server. With SSO,
users can log in once and gain access to all applications without being prompted
to log in again for each of them. If you use different sign-on credentials for the
applications on the sample server, for example when performing certain samples
and tutorials, you get an error message when you attempt to sign in to the
second application.
To avoid this issue, you must sign out of the first console and then sign in to the
second console. Alternatively, you can sign in to all of the applications on the
server by using the credentials that you entered at installation time.
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Use your application in production

Rule Designer and Event Designer are installed and you can start designing your
application in Decision Server.

Depending on your company’s needs and on the products of Operational Decision
Manager that you want to use, some configuration is required:
v To execute your rule-based application, see Configuring Rule Execution Server.
v To execute your application with event processing, see Configuring Decision

Server Events.
v To deploy the Operational Decision Manager runtime profile templates for

Websphere Application Server, see Operational Decision Manager profile
templates

v For business users to edit and test rules in Decision Center, see Configuring.

To get a better understanding of the development lifecycle with Operational
Decision Manager, see Business rule application development.
Related tasks:
Configuring Decision Server Events
“Installing the product with the sample server” on page 12
The Sample Server installation option installs the IBM Operational Decision
Manager product family along with the required software. It also creates a sample
server profile on WebSphere Application Server to run the samples and tutorials.
Related information:
Configuring Rule Execution Server on WebSphere Application Server
Configuring Decision Center on WebSphere Application Server

Upgrading to another version
Prior to upgrading to a different version of the product or adding or removing
features and functions, you might have to perform preliminary steps.
Related tasks:
“Uninstalling the product” on page 48
To uninstall Operational Decision Manager, you must use the uninstall option of
Installation Manager.
Related information:
“Installing the product with Installation Manager” on page 16
If you already installed the required software, you can use Installation Manager to
select the specific Operational Decision Manager packages that you want to install.

Upgrading Operational Decision Manager Express to
Operational Decision Manager

If you want to upgrade from Operational Decision Manager to Operational
Decision Manager, you must perform first a complete uninstallation of the product
and start on a clean slate.

You might want to upgrade from Operational Decision Manager Express to
Operational Decision Manager to benefit from the events features and the
clustering capabilities.
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In this case, you cannot simply use the Modify option of the Installation Manager
to upgrade to the fully-fledged version. You must first uninstall the Express
version completely from your computer, and then reinstall it by using the
launchpad or Installation Manager.

Upgrading from version 8.5 to version 8.5.1
Before updating an installed version to version 8.5.1, you must make sure that
there are no processes running that might access the existing version databases.

In particular, if you are using a Derby database you should make sure that the
Derby java process is not running and that there is no residual Derby lock file in
the current database directory. The presence of this file will cause the installation to
fail.

In the directory <InstallDir>/shared/data/derby/resdb, locate the file db.lck and
remove it before starting the update.

Uninstalling the product
To uninstall Operational Decision Manager, you must use the uninstall option of
Installation Manager.

Before you begin

Make sure that you stopped all the applications that run with the product,
including the server, any instance of Rule Designer or Event Designer, and the
local help process if enabled.

To uninstall the packages, you must log in to the system with the same user
account that you used to install the product packages. Make sure that you are
using the correct instance of Installation Manager to uninstall the product:
v If you installed the products as an administrator, you must uninstall it by using

the administrator instance of Installation Manager, which is accessible through
the IBM Installation Manager start menu shortcut.

v If you installed the products as a nonadministrator user, you must uninstall it
by using the nonadministrator instance of Installation Manager, which is
accessible through the My IBM Installation Manager start menu shortcut.

To be able to uninstall WebSphere Application Server and WebSphere eXtreme
Scale properly, you must delete the ODMSample8500 profiles manually first. These
profiles are created when you install the product by using the Sample server
installation option of the launchpad. For more information, see Deleting profiles.

A package cannot be uninstalled when another package has a dependency on it,
unless the dependent package is also selected to be uninstalled.

Procedure
1. Close the programs that you installed with Installation Manager.
2. Launch Installation Manager from the Start menu.
3. Select the components that you want to uninstall, then click Next and

Uninstall.
Related concepts:
“Upgrading to another version” on page 47
Prior to upgrading to a different version of the product or adding or removing
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features and functions, you might have to perform preliminary steps.
“Installation options” on page 7
Before you install IBM Operational Decision Manager, consider how you want to
use Decision Server and Decision Center, and whether you plan to configure them
on an existing production server. You have several installation options from which
you can select depending on your needs.
“Installing the product with the launchpad” on page 10
Operational Decision Manager comes with a launchpad that helps you install the
product along with the additional required software. The launchpad has two
installation options: Sample Server and Custom Installation.
Related information:
“Installing the product with Installation Manager” on page 16
If you already installed the required software, you can use Installation Manager to
select the specific Operational Decision Manager packages that you want to install.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM United Kingdom Laboratories,
Mail Point 151,
Hursley Park,
Winchester,
Hampshire,
England SO21 2JN

For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those
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websites. The materials at those websites are not part of the materials for this IBM
product and use of those websites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM United Kingdom Laboratories,
Mail Point 151,
Hursley Park,
Winchester,
Hampshire,
England SO21 2JN

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or

52 IBM Operational Decision Manager: Installation Guide



imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp.
Sample Programs. © Copyright IBM Corp. _enter the year or years_.

Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “Copyright and
trademark information” at www.ibm.com/legal/copytrade.shtml.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

Microsoft, Windows, and the Windows logo are trademarks of Microsoft
Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.
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